SENATE COMMITTEE ON CURRICULAR AFFAIRS
COURSE SUBMISSION AND CONSULTATION FORM

Principal Faculty Member(s) Proposing Course

<table>
<thead>
<tr>
<th>Name</th>
<th>User ID</th>
<th>College</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mark Edward Ballora</td>
<td>meb26</td>
<td>Arts and Architecture (AA)</td>
<td>Not Available</td>
</tr>
</tbody>
</table>

Academic Home: Arts and Architecture (AA)
Type of Proposal: [X] Add  [ ] Change  [ ] Drop

Course Designation
(INART 50Z) The Science of Music

Course Information
Cross-Listed Courses:

Prerequisites:

Corequisites:

Concurrents:

Recommended Preparations:

Abbreviated Title: Sci Mus
Discipline: General Education
Course Listing: Linked

Special categories for Undergraduate (001-499) courses

Foundations

☐ Writing/Speaking (GWS)
☐ Quantification (GQ)

Knowledge Domains

☐ Health & Wellness (GHW)
[X] Natural Sciences (GN)
☐ Arts (GA)
☐ Humanities (GH)
☐ Social and Behavioral Sciences (GS)

Additional Designations

[X] Bachelor of Arts

☐ International Cultures (IL)
☐ United States Cultures (US)
☐ Honors Course
☐ Common course number - x94, x95, x96, x97, x99
☐ Writing Across the Curriculum

First-Year Engagement Program

☐ First-Year Seminar

Miscellaneous
Course Outline

A brief outline or overview of the course content:
INART 050Z SCIENCE OF MUSIC (3) The physical and acoustic properties of music, including the nature of wave behavior, sound propagation, auditory perception, the basis of musical scales, and the nature of musical instruments, and room acoustics, including curricular links to MUSIC 011Z UNDER THE HOOD: HOW CLASSICAL MUSIC WORKS.

A listing of the major topics to be covered with an approximate length of time allotted for their discussion:

Weeks 1 through 5
Fundamentals of Acoustics
• Sound Events
• Simple Harmonic Motion
• Wave Characteristics
• Refraction and Reflection
• Superposition
• Standing Waves, Resonant Frequencies, and Harmonics
• Phase
• Speed and Velocity

Week 6 through 7
Hearing and the Human Auditory System
• Physiology of the Auditory System
• Psychoacoustics
• Gestalt Perception and Auditory Scene Analysis

Week 8 Tuning and Scales
Musical Scales
• The significance of the octave and perfect fifth
• Pitch class and the harmonic series
• Pythagorean and just tunings
• Equal temperament

Weeks 9 through 12
The Nature of Musical Instruments and the Voice
• The first instruments: voice and percussion
• The woodwind family
• The brass family
• The violin family and string instruments

Week 13 Room Acoustics and Audio Technology

Week 14 Audio Technology

Week 15 Auditory Display and Sonification

Course Description:
Waves, physics of sound, hearing, musical scales, musical instruments, and room acoustics. INART 50Z The Science of Music (3) (GN)/(BA) meets the Bachelor of Arts degree requirements and includes curricular links to MUSIC 011Z UNDER THE HOOD: HOW CLASSICAL MUSIC WORKS. This course explores the physical and acoustical bases of sound and music. The physics include a
study of vibrating systems and simple harmonic motion, wave propagation, reflection and refraction, superposition, resonant
frequencies, harmonics, phase, the relationship of speed and velocity, and spectra. The acoustics portion applies these physical
properties to hearing, sound and music, covering the nature of the human auditory system, and correlations of pitch to frequency,
loudness to amplitude/power/intensity, timbre to spectra and envelope. An overview of perceptual psychological studies of Gestalt
organizational principles and auditory streaming explores how the auditory system organizes sound on a primitive, unlearned level.
NOTE: there need be no specific math prerequisite for the course. Though high school algebra and trigonometry will be
recommended, these topics will be integrated with the rest of the course material. With physical and physiological groundwork laid,
the subject matter moves to purely musical areas: the construction of musical scales, the nature of consonance, dissonance, and
harmony. Twelve-tone equal temperament, the basis of Western common practice music, is not an absolute, but a decision made
to facilitate certain musical choices, and a compromise in terms of optimal consonance. The nature of the different instruments is
then discussed - strings, winds, brass, percussion, and voice. Different instruments naturally produce different scale types and
different types of spectra. Students will learn to appreciate the inherent differences in different instrument types. The course then
returns to acoustics, exploring the role that performance spaces play in the propagation and reception of sound. The shape and
materials of a room determine its characteristic sound. Students learn about how sound in large auditoriums is characterized by
the balance of direct and reflected sound, the distinction between specular and diffuse reflections, the absorptive properties of
different building materials, and the nature of reverberation. Smaller performance spaces are subject to standing waves, flutter echo,
and comb filtering. Taking steps to avoid undesirable characteristics is often an easy matter once the nature of these
characteristics is understood. The final weeks cover audio technology and the distinctions between analog and digital formats. The
course ends with a unit on auditory display and sonification, wherein scientific data may be presented through musical sound.

INART 50Z and MUSIC 11Z are linked courses

The name(s) of the faculty member(s) responsible for the development of the course:

Name: Mark Edward Ballora (meb26)
Title:
Phone:
Address: Campus: UP
City:
Fax:

Course Justification

Instructional, Educational, and Course Objectives:
This section should define what the student is expected to learn and what skills the student will develop.
A thorough understanding of music arises not only from the study of its subjective elements and tonal systems of harmony and
counterpoint, but also from a study of the acoustic and physical principles on which these systems are based. String players are
taught to touch a string lightly to produce a “harmonic,” but are not necessarily aware of why the change in pitch occurs. Brass
players struggle to play in tune, without knowing that equally tempered pitches are not produced naturally by their horns.
Performers observe intuitively that some venues sound better than others, but have little understanding of the acoustic properties
that create a hall’s “characteristic sound.” Acoustics are traditionally a component of musical studies in Europe, but not
necessarily in America.

While the benefits of knowing the science of music are clear for music majors, these topics are also valuable to students in other
fields. As music is a vital part of virtually everyone’s life, a course like this can be an ideal way to introduce them to properties of
vibrations, waves, resonances, spectra, etc., that are also inherent components of other scientific pursuits. Thus, as students learn
to appreciate the music they listen to, they can also gain a better understanding of nature – a goal in all studies of natural science.

Upon completion of the course, students will be able to enter formulae and plot graphs in a spreadsheet, be able to explain basics of
trigonometry and logarithms, as well as explain the nature of waves and resonance, how the auditory system processes sound,
the differences among musical instrument families, and come to a basic determination of why some venues are more suitable for
music than others, and explain how audio technology works.

Evaluation Methods:
Include a statement that explains how the achievement of the educational objective identified above will be assessed.
The procedures for determining students’ grades should be specifically identified.
Grading will be based on:
• Weekly homework assignments
• Two midterm exams
• One final exam

Weekly homework assignments reinforce concepts covered in class. Mathematical concepts such as trigonometric functions and
logarithms are applied to physics math problems concerning wave functions, the construction of musical scales, and decibel
measurements. Some homework assignments are written math problems, others will involve the use of PSU computer labs to plot
waves with a spreadsheet, and still others use sound editing software to critically analyze audio files.

Exams emphasize deeper understanding with multiple choice questions that relate topics to one another and require that students
integrate the material covered throughout the different course units.

Relationship/Linkage of Course to Other Courses:
This statement should relate the course to existing or proposed new courses. It should provide a rationale for the level
of instruction, for any prerequisites that may be specified, or for the course’s role as a prerequisite for other courses.

INART 050Z THE SCIENCE OF MUSIC (3) is related to course work in areas such as music technology, music education,
Relationship of Course to Major, Option, Minor, or General Education:
This statement should explain how the course will contribute to the major, option, or minor and indicate how it may function as a service course for other departments.
INART 050Z THE SCIENCE OF MUSIC (3) is proposed as an approved course for General Education (GN). It is a required course for the minor in music technology (MUTC) and for the BA in Music (MUSBA) Music Technology option. The course will satisfy 3 GN credits toward the General Education requirement, and can satisfy 3 credits towards the 6 credit integrative studies component of the general education requirement, provided students also take MUSIC 011Z UNDER THE HOOD: HOW CLASSICAL MUSIC WORKS, which would then complete the integrative studies requirement.

A description of any special facilities:
INART 050Z THE SCIENCE OF MUSIC (3) relies heavily on demonstrations. It requires a technology-equipped classroom that includes a computer, projection system, DVD/video player and high-quality audio playback.

Frequency of Offering and Enrollment:
The course is offered fall semesters at University Park; enrollment is currently 150 seats, based on room capacity.

Alignment with General Education Objectives

[X] EFFECTIVE COMMUNICATION – the ability to exchange information and ideas in oral, written, and visual form in ways that allow for informed and persuasive discourse that builds trust and respect among those engaged in that exchange, and helps create environments where creative ideas and problem-solving flourish.

[X] KEY LITERACIES – the ability to identify, interpret, create, communicate and compute using materials in a variety of media and contexts. Literacy acquired in multiple areas, such as textual, quantitative, information/technology, health, intercultural, historical, aesthetic, linguistic (world languages), and scientific, enables individuals to achieve their goals, to develop their knowledge and potential, to lead healthy and productive lives, and to participate fully in their community and wider society.

[X] CRITICAL AND ANALYTICAL THINKING – the habit of mind characterized by comprehensive exploration of issues, ideas, artifacts, and events before accepting or formulating a conclusion. It is the intellectually disciplined process of conceptualizing, applying, analyzing, synthesizing, and/or evaluating information gathered from, or generated by, observation, experience, reflection, reasoning, or communication, as a guide to belief and action.

[X] INTEGRATIVE THINKING – the ability to synthesize knowledge across multiple domains, modes of inquiry, historical periods, and perspectives, as well as the ability to identify linkages between existing knowledge and new information. Individuals who engage in integrative thinking are able to transfer knowledge within and beyond their current contexts.

[X] CREATIVE THINKING – the capacity to synthesize existing ideas, images, or expertise in original ways and the experience of performing, making, thinking, or acting in an imaginative way that may be characterized by innovation, divergent thinking, and intellectual risk taking.

[X] GLOBAL LEARNING – the intellectually disciplined abilities to analyze similarities and differences among cultures; evaluate natural, physical, social, cultural, historical, and economic legacies and hierarchies; and engage as community members and leaders who will continue to deal with the intricacies of an ever-changing world. Individuals should acquire the ability to analyze power; identify and critique interdependent global, regional, and local cultures and systems; and evaluate the implications for people’s lives.

[X] SOCIAL RESPONSIBILITY AND ETHICAL REASONING – the ability to assess one’s own values within the social context of problems, recognize ethical issues in a variety of settings, describe how different perspectives might be applied to ethical dilemmas, and consider the ramifications of alternative actions. Individuals should acquire the self Knowledge and leadership skills needed to play a role in creating and maintaining healthy, civil, safe, and thriving communities.

What component(s) of the course will help students achieve the General Education Learning Objectives covered in the course? Provide evidence that students in the course have adequate opportunities to achieve the identified learning objectives.

Effective Communication: this course provides essential groundwork in the foundational materials of music. With understanding comes the ability to communicate in new ways. Much of music is subjective and understood intuitively. And much of it can also be understood in concrete terms. A solid grounding in what can be understood in concrete terms leads to a richer appreciation of the aspects of music that cannot be explained in concrete terms. It also enables musicians to communicate more clearly to each other in rehearsal and performance situations.

Key Literacies: this course covers concepts that underlie musical sound and human perception of it. Understanding is reinforced through exercises in relevant mathematics and spreadsheet graphing functions, which are applicable to many aspects of life beyond this one course.

Critical and Analytical Thinking: the course's material is reinforced through homework and examinations, but in different ways. Homework assignments are exercises in mechanics, such as how to do certain math problems, or how to do basic spreadsheet formulas. Examinations call for deep understanding beyond mechanics. Many of the concepts rely on student's being able to assemble information presented at various points in the term (e.g., brass instruments operate by the players' buzzing the lips, which activates different harmonic resonances of the instrument's body; therefore, the instruments favor being played in Just intonation, since Just intonation is based on pitch relationships that can be found in the natural harmonic series. Another example is that rooms can behave like resonators and favor certain standing wave frequencies).

Integrative Thinking: the course material reinforces topics that appear in many other subjects, among them music theory, music education, music production, mechanical and electrical engineering, physics, and acoustics. Students are shown how fundamental
principles that govern our universe (such as wave behavior, resonance, harmonic vibration) also underlie music, which is something that everyone appreciates on an instinctive level. An appreciation of how these principles underlie music leads to an appreciation of how these principles underlie these other fields in analogous ways.

How will students be assessed to determine their attainment of the Learning Objective(s) of General Education covered in this course? This assessment must be included as a portion of the student's overall performance in this course.

Students are assessed through homework assignments and in-class examinations. Homework assignments train students in a variety of problem solving tasks, involving the synthesis of math, acoustics, and music. Students will become adept at skills such as using trigonometric functions to plot waveforms; understanding graphs of sound spectra, room absorption coefficients, and the like; understanding the mathematical basis of musical scales; and analyzing spectrograms of musical instruments. Examinations require that students relate concepts to each other that are covered throughout the course. The homework assignments are exercises meant to strengthen certain mental muscles, like calisthenics. The tests ask for deeper conceptual understanding.

General Education Domain Criteria

General Education Designation: Linked

Linked Courses
- MUSIC 11Z

GN Criteria

- Explain the methods of inquiry in the natural science fields and describe how the contributions of these fields complement inquiry in other areas
- Construct evidence-based explanations of natural phenomena
- Demonstrate informed understandings of scientific claims and their applications
- Evaluate the quality of the data, methods, and inferences used to generate scientific knowledge
- Identify societal or philosophical implications of discoveries in the natural sciences, as well as their potential to address contemporary problems

What components of the course will help students achieve the domain criteria selected above?

The math and graphic exercises give students quantitative skills in understanding the workings of vibrations and how they are at the basis of sound, musical material, auditory perception, room acoustics, and audio technology. Success in these exercises relies on quantitative reasoning and a good understanding of the goals of the exercises. This understanding gives students concrete, evidence-based comprehension of how physical systems behave when they vibrate, and how these behaviors lead to qualities of music and auditory perception. These informed understandings give students the tools to understand scientific claims and the ability to think critically about emerging issues in music and technology, such as being able to appreciate the differences between compressed and uncompressed audio files, or why Just intonation offers enhanced harmonicity but at the expense of compositional flexibility. This level of understanding can only be attained by the scientific method of understanding behaviors through equations, and understanding how these equations relate to one another.

Integrative Studies

Explain how the intellectual frameworks and methodologies of each course's Knowledge Domain will be explicitly addressed in the course and practiced by the students.

In MUSIC 011Z, open forums provide students great latitude and are like classroom discussions. On the discussion boards, the group of students who are assigned to that board will select from a list of topics for their initial posts, and respond to two or three of their groupmates' initial posts. For the concert review assignment, students choose to attend a performance, selecting from a list of professional performances provided for that semester. For the final reflection paper, students are invited to reflect on the experience of studying classical music in the course, to consider what they have learned, cite notable composers and compositions, and consider the value of the experience. In each case, the instructor is assessing the substance and quality of the student's writing, with an eye for the student's demonstration of effective communication, critical "reading" of musical materials and performance, and critical and analytical thinking.

In INART 050Z, students are trained in a variety of problem solving tasks, involving the synthesis of math, acoustics, and music. Students apply skills such as using trigonometric functions to plot waveforms in a spreadsheet; understanding graphs of sound spectra, room absorption coefficients, and the like; understanding the mathematical basis of musical scales; and analyzing spectrograms of musical instruments. Examinations require that students relate concepts to each other that are covered throughout the course. Homework assignments are exercises meant to strengthen certain mental muscles (like calisthenics), while examinations require deeper conceptual understanding of linkages among course topics.

As a science course, the focus of INART 050Z is on problem solving, understanding how to derive correct solutions to problems when it is possible to do so, and understanding what aspects of musical perception cannot be explained through quantitative problem solving. As a science course, its methodologies are quantitative, based on a rational understanding of problems and their contexts, and the equations that describe these problems. As a science of music course, it exemplifies how quantitative understanding and mathematical skills can embody and lead to a greater appreciation of the sublime.

In MUSIC 011Z, students will be introduced to the scientific foundation of music making, explicitly examining elements relating to pitch frequency, arithmetic ratios between pitches, intervals, the natural harmonic series, and how these scientific elements underlie the creation of musical scales, tunings, and ultimately the development of the musical language of tonality.

Explain how the courses in the Linkage will be linked with each other. It is anticipated that courses will usually be linked by subject matter, but they should additionally be linked by some purposeful component that provides opportunities for students to experience and practice integrative thinking across Knowledge Domains. The Linkage component between courses needs to be intentional and explicit to students. However, each course in a Linkage must be self-contained such that students can successfully complete just one course in the Linkage if they so choose.
The two courses share a common foundation. Both rely on an understanding of vibrations, resonance, the natural harmonic series, the creation of musical scales, the nature of consonance and dissonance, the creation of musical scales, and an understanding of timbre and the differences between the instrument families. MUSIC 011Z takes this foundation into areas pertaining to the historical development of musical form and composition. INART 050Z takes this same foundation into areas of physical sciences, focusing on wave behavior, perception and cognition, and audio technologies. MUSIC 011Z is a historical overview of the development of an art form and its expressive capacities. INART 050Z is a quantitative overview of the physical and cognitive foundations that allow this art to exist in our world. MUSIC 011Z gives students a sense of what music has meant to people throughout history. INART 050Z gives students a sense of how music exemplifies physical constants of our universe, such as resonance and wave transmission. INART 050Z covers aspects of music that can be explained concretely and quantitatively. MUSIC 011Z covers aspects of music that are subjective and are understood intuitively. The two perspectives are complementary, and both are necessary for a meaningful understanding of how and why music has been vital and important to society and culture throughout history.

Briefly explain the staffing plan. Given that each Linked course is approved for a single Knowledge Domain, it will be taught by an instructor (or instructional team) with appropriate expertise in that domain, who will also be expected to implement the Linkage’s shared component as defined in this proposal.

INART 050Z will be taught by a specialist in music technology, a field that requires expertise in both the artistic elements of music creation and a scientific understanding of the physical properties of music. MUSIC 011Z will be taught by a music theorist, historian, or performer with appropriate expertise in theory, history, and performance. Mark Ballora is the original proposer and author of INART 050, and Stephen Hopkins is the original proposer and author of Music 011. The two have collaborated in the proposal of these linked courses: INART 050Z and MUSIC 011Z. Curricular elements that link the two courses have been incorporated in each proposal.

Describe the assessments that will be used to determine students’ ability to apply integrative thinking.

In INART 050Z, students are guided through the physical foundations of music. Throughout the course, connections are made between the concrete nature of the physical sciences and the abstract nature of the fine arts. Musical examples are used throughout to explain topics such as tunings, the instrument families, and the nature of room acoustics, and how music written in different historical periods was written to suit the spaces in which it was performed (such as large cathedrals or small salons). The material is inherently integrative, and really needs no special effort to connect the scientific to the artistic. The homework assignments and tests, with their different approaches to the material (described above) ensure that students grasp the underlying nature of musical material.

In MUSIC 011Z, written assignments will include responses on open forums and assigned topics on discussion boards, both of which will allow students to respond to one another and to learn from one another. In addition, there are two papers submitted directly to the instructor. All of these written assignments will prompt students with suggested topics and questions that encourage students to apply integrative thinking and provide them opportunities to demonstrate their abilities in this regard. Given the interrelationships between the art of music and the science of music, there will be ample material with which the students engage that will demonstrate their ability to apply integrative thinking.

General Education Designation Requirements

Bachelor Of Arts Requirements:

- BA: Natural Sciences
- BA: Other Cultures
- BA: Foreign/World Lang (12th Unit)
- BA: Humanities
- BA: Social and BA: Behavioral Sciences
- BA: Arts
- BA: Quantification
- BA: Foreign/World Lang (All)

INART 050Z will satisfy a Bachelor of Arts requirement, just as INART 50 has since it was approved.

Campuses That Have Offered ( ) Over The Past 4 Years
UPLOADED DOCUMENTS FOLLOW:
Syllabus

INART 50 Science of Music

3 credits
Pre-requisites: none

Course attributes:
GN, BA
INART 50Z is a Linked Course with MUSIC 11Z

Mark Ballora, instructor
ballora@psu.edu

Office: 227 Theatre Building
Phone: 814 863-3386
Office hours: Mon & Thurs 1:00-2:00 and by appt.

Fall 2017
Class meeting times:
Tuesday, Thursday 9:05 - 10:20
110 Business Building

General Education Learning Objectives

- **Effective Communication**: this course provides essential groundwork in the foundational materials of music. With understanding comes the ability to communicate in new ways. Much of music is subjective and understood intuitively. And much of it can also be understood in concrete terms. A solid grounding in what can be understood in concrete terms leads to a richer appreciation of the aspects of music that cannot be explained in concrete terms. It also enables musicians to communicate more clearly to each other in rehearsal and performance situations.

- **Key Literacies**: this course covers concepts that underlie musical sound and human perception of it. Understanding is reinforced through exercises in relevant mathematics and spreadsheet graphing functions, which are applicable to many aspects of life beyond this one course.

- **Critical and Analytical Thinking**: the course's material is reinforced through homework and examinations, but in different ways. Homework assignments are exercises in mechanics, such as how to do certain math problems, or how to do basic spreadsheet formulas. Examinations call for deep understanding beyond mechanics. Many of the concepts rely on student's being able to assemble information presented at various points in the term (e.g., brass instruments operate by the players' buzzing the lips, which activates different harmonic resonances of the instrument's body; therefore, the instruments favor being played in Just intonation, since Just intonation is based on pitch relationships that can be found in the natural harmonic series. Another example is that rooms can behave like resonators and favor certain standing wave frequencies).
• **Integrative Thinking:** the course material reinforces topics that appear in many other subjects, among them music theory, music education, music production, mechanical and electrical engineering, physics, and acoustics. Students are shown how fundamental principles that govern our universe (such as wave behavior, resonance, harmonic vibration) also underlie music, which is something that everyone appreciates on an instinctive level. An appreciation of how these principles underlie music leads to an appreciation of how these principles underlie these other fields in analogous ways.

**Course Description**

Waves, physics of sound, hearing, musical scales, musical instruments, and room acoustics. INART 050Z The Science of Music (3) (GN)(BA) meets the Bachelor of Arts degree requirements and includes curricular links to MUSIC 011Z UNDER THE HOOD: HOW CLASSICAL MUSIC WORKS. This course explores the physical and acoustical bases of sound and music. The physics include a study of vibrating systems and simple harmonic motion, wave propagation, reflection and refraction, superposition, resonant frequencies, harmonics, phase, the relationship of speed and velocity, and spectra. The acoustics portion applies these physical properties to hearing, sound and music, covering the nature of the human auditory system, and correlations of pitch to frequency, loudness to amplitude/power/intensity, timbre to spectra and envelope. An overview of perceptual psychological studies of Gestalt organizational principles and auditory streaming explores how the auditory system organizes sound on a primitive, unlearned level. NOTE: there need be no specific math prerequisite for the course. Though high school algebra and trigonometry will be recommended, these topics will be integrated with the rest of the course material. With physical and physiological groundwork laid, the subject matter moves to purely musical areas: the construction of musical scales, the nature of consonance, dissonance, and harmony. Twelve-tone equal temperament, the basis of Western common practice music, is not an absolute, but a decision made to facilitate certain musical choices, and a compromise in terms of optimal consonance. The nature of the different instruments is then discussed - strings, winds, brass, percussion, and voice. Different instruments naturally produce different scale types and different types of spectra. Students will learn to appreciate the inherent differences in different instrument types. The course then returns to acoustics, exploring the role that performance spaces play in the propagation and reception of sound. The shape and materials of a room determine its characteristic sound. Students learn about how sound in large auditoriums is characterized by the balance of direct and reflected sound, the distinction between specular and diffuse reflections, the absorptive properties of different building materials, and the nature of reverberation. Smaller performance spaces are subject to standing waves, flutter echo, and comb filtering. Taking steps to avoid undesirable characteristics is often an easy matter once the nature of these characteristics is understood. The final weeks cover audio technology and the distinctions between analog and digital formats. The course ends with a unit on auditory display and sonification, wherein scientific data may be presented through musical sound. Grading will be based on weekly homework assignments, two midterm exams and a final exam.

**Course Learning Objectives**

A thorough understanding of music arises not only from the study of its subjective elements and tonal systems of harmony and counterpoint, but also from a study of the acoustic and physical principles on which these systems are based. String players are taught to touch a string lightly to produce a “harmonic,” but are not necessarily aware of why the change in pitch occurs. Brass
players struggle to play in tune, without knowing that equally tempered pitches are not produced
naturally by their horns. Performers observe intuitively that some venues sound better than
others, but have little understanding of the acoustic properties that create a hall’s “characteristic
sound.” Acoustics are traditionally a component of musical studies in Europe, but not necessarily
in America.

While the benefits of knowing the science of music are clear for music majors, these topics are
also valuable to students in other fields. As music is a vital part of virtually everyone’s life, a
course like this can be an ideal way to introduce them to properties of vibrations, waves,
resonances, spectra, etc., that are also inherent components of other scientific pursuits. Thus, as
students learn to appreciate the music they listen to, they can also gain a better understanding of
nature – a goal in all studies of natural science.

The math and graphic exercises give students quantitative skills in understanding the workings of
vibrations and how they are at the basis of sound, musical material, auditory perception, room
acoustics, and audio technology. Success in these exercises relies on quantitative reasoning and a
good understanding of the goals of the exercises. This understanding gives students concrete,
evidence-based comprehension of how physical systems behave when they vibrate, and how
these behaviors lead to qualities of music and auditory perception. These informed
understandings give students the tools to understand scientific claims and the ability to think
critically about emerging issues in music and technology, such as being able to appreciate the
differences between compressed and uncompressed audio files, or why Just intonation offers
enhanced harmonicity but at the expense of compositional flexibility. This level of understanding
can only be attained by the scientific method of understanding behaviors through equations, and
understanding how these equations relate to one another.

Students are assessed through homework assignments and in-class examinations. Homework
assignments train students in a variety of problem solving tasks, involving the synthesis of math,
acoustics, and music. Students will become adept at skills such as using trigonometric functions
to plot waveforms; understanding graphs of sound spectra, room absorption coefficients, and the
like; understanding the mathematical basis of musical scales; and analyzing spectrograms of
musical instruments. Examinations require that students relate concepts to each other that are
covered throughout the course. The homework assignments are exercises meant to strengthen
certain mental muscles, like calisthenics. The tests ask for deeper conceptual understanding.
Please use the links below to navigate through the course contents
(They can also be accessed directly from the course website at
http://www.personal.psu.edu/meb26/INART50/main.html)

Course schedule
(http://www.personal.psu.edu/meb26/INART50/schedule.html)

How to order the textbook
(http://www.personal.psu.edu/meb26/INART50/textordering.html)

Homework assignments
(http://www.personal.psu.edu/meb26/INART50/assignments.html)

Demonstrations
(http://www.personal.psu.edu/meb26/INART50/demos.html)

Advice for Students on How to Email Professors
(https://www.insidehighered.com/views/2015/04/16/advicestudentsotheydonsilysayasu
utm_content=buffer1f81f&utm_medium=social&utm_source=facebook&utm_campaign=IHEbu
ffer)

Instructions for uploading homework assignments to Canvas
(https://psu.instructure.com/files/85946159/download?download_frd=1)
# INART 50
## Science of Music
### Schedule
#### Fall 2017

Subject to change. Please check this page often.

<table>
<thead>
<tr>
<th>Week 1</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| August 22, 24 | Introduction  
Textbook pp. 1-4 | Sound = Vibration  
Textbook pp. 5-13 |
| | Course Introduction  
Youtube video: [What is up with Noises?](#) | - Sound = Vibration  
- Trigonometry Basics, part 1  
- Spreadsheets, part 1 - performing arithmetic |

<table>
<thead>
<tr>
<th>Week 2</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| August 29, 31 | The Anatomy of Sinusoidal Waves  
Textbook pp. 15-27 | Waves  
Textbook pp. 29-40 |
| | - Spreadsheets, part 2: plotting sinusoids  
Helpful Link: [http://www.purplemath.com/modules/triggrph.htm](http://www.purplemath.com/modules/triggrph.htm)  
Due date for optional math pre-test | - Spreadsheet Basics, pt. 3 (find RMS)  
[Homework Packet 1 due](#) |

<table>
<thead>
<tr>
<th>Week 3</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| September 5, 7 | Standing Waves  
Textbook pp. 41-43 | Resonance  
Textbook pp. 45-53 |
| | - Spreadsheet basics, 4: Adding Sinusoidal Waves | - Radicals and Exponents  
[Homework Packet 2 due](#) |

<table>
<thead>
<tr>
<th>Week 4</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| September 12, 14 | Resonance, cont'd  
- Exponential Growth and Decay | Harmonics  
Textbook pp. 55-61 |
| | | - Complex Vibrations  
- Logarithms and Logarithmic Functions  
[Levitating water drops in an acoustic field](#)  
[Homework Packet 3 due](#) |

<table>
<thead>
<tr>
<th>Week 5</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| September 19, 21 | The Power of Sound  
Textbook pp. 63-69 | Timbre  
Textbook pp. 71-81 |
| | | [Homework Packet 4 due](#) |

| Week 6 | Tuesday | Thursday |
**Week 7**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| October 3, 5 | No Class Session | **The Human Auditory System**  
- Textbook pp. 83-92  
- "We're Wired to Sing"  
- Homework Packet 5 due |

**Week 8**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| October 10, 12 | Psychoacoustics  
- Textbook pp. 93-102 | **Auditory Scene Analysis**  
- Textbook pp. 103-113  
- Homework Packet 6 due |

**Week 9**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| October 17, 19 | **Tuning and Scales, pt. 1**  
- Textbook pp. 115-125 | **Tuning and Scales, pt. 2** |

**Week 10**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| October 24, 26 | **The Violin Family**  
- Textbook pp. 151-158 | **The Woodwind Family**  
- Textbook pp. 135-142  
- Philharmonia Orchestra: Violin  
- Philharmonia Orchestra: Viola  
- Philharmonia Orchestra: Cello  
- Philharmonia Orchestra: Double Bass  
- Philharmonia Orchestra: Flute  
- Philharmonia Orchestra: Clarinet  
- Philharmonia Orchestra: Oboe  
- Philharmonia Orchestra: Bassoon  
- Philharmonia Orchestra: Saxophone |

**Week 11**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| October 31, November 2 | **The Brass Family**  
- Textbook pp. 143-149 | **The First Instruments: The Voice and Percussion**  
- Textbook p. 127-133  
- Physics of the Trumpet  
- Philharmonia Orchestra: Trumpet  
- Philharmonia Orchestra: Trombone  
- Philharmonia Orchestra: Horn  
- Philharmonia Orchestra: Tuba  
- Tibetan Throat Singing video  
- Tuvan throat singing video |

**Week 12**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| November 7, 9 | Review for Midterm 2 | Midterm 2  
- Homework Packet 8 due |

**Week 13**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| November 14, 16 | **Room Acoustics, pt. 1**  
- Textbook pp. 159-175 | **Room Acoustics, pt. 2**  
- Room Mode Calculator spreadsheet (available on Lessons page)  
- National Geographic News: Stone Age Art Caves May Have Been Concert Halls  
- Homework Packet 9 due |

**Week 14**

<table>
<thead>
<tr>
<th>Date</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
</table>
| November 28, 30 | **Audio Technology - Analog**  
- Textbook pp. 177-189  
- Animation of DC powering a light bulb  
- Animation comparing voltage of DC and AC | **Audio Technology - Digital**  
- Textbook pp. 191-202  
- Bob Weir on Internet music delivery and MP3 audio |
<table>
<thead>
<tr>
<th>Week 15</th>
<th>Tuesday</th>
<th>Thursday</th>
</tr>
</thead>
<tbody>
<tr>
<td>December 5, 7</td>
<td>Auditory Display and Sonification</td>
<td>FINAL REVIEW</td>
</tr>
</tbody>
</table>

**Cumulative Final exam:**
**Thursday, December 14**
6:50-8:40 PM
Last names A-N - 162 Willard Bldg.
Last names O-Z - 69 Willard Bldg.

[Home](#)  |  [Class schedule](#)  |  [Demonstrations](#)  |  [Assignments](#)
INART 50
Science of Music

Assignments

Remember: NEATNESS COUNTS!!! SO DO LANGUAGE SKILLS!!!
Numbers should be legible;
paragraphs should be typed, spell checked and proofread;
sentences should be complete, grammar should be correct.
Math problems may be handwritten, but should be legible.
(Do not expect to staple them in class. Do the stapling beforehand.)
Points will be taken off if work is sloppy or has spelling or grammatical errors.

See the Schedule page for due dates

All assignments are to be submitted online via Canvas

How is the homework graded?
Each homework item will receive a mark of check, check-minus, or check-minus-minus.
When semester grades are calculated, checks count as a full point (1.0), check-minuses count as 0.8 points, check-minus-minuses count for 0.7.

Optional Math Pre-test
There is an optional "opt out" test that students may take that draws from the early math homework. It's available on Canvas, on the Files page. You may take this and test out of some of the upcoming homework if you wish. There is no penalty for taking it and not passing.

Homework Packet 1 (2% of semester grade)
1. Degrees to Radians problems [Students who passed these problems on the optional pre-test do not need to submit this homework component.]
2. Using a spreadsheet, create a budget sheet, as shown in class. Click here for an example of what it should look like. This example is only a suggestion. There is no set format, minimum entries, or any small specifics that I am looking for. The point of this exercise is to make it clear that you know how to use basic formulas. (Students have pointed out that it would be easy to fake a submission. This may be true, but consider this to be an "on-your-honor" submission. Formulas will be necessary for upcoming assignments; the wise course of action is to learn them now.)
   To review entering formulas in Excel, click here for a tutorial PDF.

Homework Packet 2 (5% of semester grade)
1. Plotting Angles on the Unit Circle [Students who passed these problems on the optional pre-test do not need to submit this homework component.]
2. Using a spreadsheet program, plot at least one period of a sinusoidal wave. Be sure you can easily change its frequency, amplitude, and initial phase. It's only necessary to submit a PDF of the graph. Don't bother submitting your entire spreadsheet. The easiest way to do this is to select the chart, go to Edit -> Copy, then switch to another program such as Microsoft Word and go to Edit -> Paste, putting the chart into a Word document that you can print.
3. Write a brief paragraph explaining the relationship of a sine wave plot to a sine wave tone. i.e., What physical phenomenon does the plot represent? Keyword: air pressure
4. Write a brief paragraph explaining the difference between longitudinal waves and transverse waves. Give at least one example of each.

Homework Packet 3 (5% of semester grade)
1. **Simplifying Radicals worksheet** [Students who passed these problems on the optional pre-test do not need to submit this homework component.]

2. Using a spreadsheet program, plot the sum of two waves at different frequencies, showing both waves and the composite wave. It’s only necessary to submit a PDF of the graph. Don’t bother submitting your entire spreadsheet. The easiest way to do this is to select the chart, go to Edit -> Copy, then switch to another program such as Microsoft Word and go to Edit -> Paste, putting the chart into a Word document that you can print.

3. **Radicals as Exponents worksheet** [Students who passed these problems on the optional pre-test do not need to submit this homework component.]

4. **Exponential properties worksheet** [Students who passed these problems on the optional pre-test do not need to submit this homework component.]

5. Using a spreadsheet, create one period of a sine wave. Square all values of the sine wave. [Excel formula: =value^2] and plot a chart of them. Then take the mean of these values. What is the mean of all values? [Excel formula: =AVERAGE(value range)] (Scroll over the range of cells to make the value range appear, or just type them if you happen to know the starting and ending cells, e.g., D1:D360) Take the square root of the mean. [Excel formula: =SQRT(value)] What is the RMS value? Submit a PDF of the sine squared plot, and show enough cells to verify that you successfully derived the RMS value.

**EXTRA CREDIT OPPORTUNITY:**

This may be submitted at any time during the semester. The final submission date will be at the end of the term (see the Schedule for the due date). Each plot will add 3% to the semester grade, so that a total of 6 points may be gained by submitting both of these plots.

1. Using a spreadsheet, plot a square wave. A square wave has frequencies of f, 3f, 5f, 7f, etc., and corresponding amplitudes at 1, 1/3, 1/5, 1/7, ... **Plot and show at least ten partials, as well as the composite wave (the sum of all the harmonics you plot).**

   NOTE: A square wave looks something like this:

   ![Square Wave Example](image)

   (The more harmonics are added, the closer its shape comes to being a perfect square.)

2. Using a spreadsheet, plot a sawtooth wave. A sawtooth wave has frequencies of f, 2f, 3f, 4f, etc., and corresponding amplitudes at 1, 1/2, 1/3, 1/4, ... **Plot and show at least ten partials, as well as the composite wave (the sum of all the harmonics you plot).** (Adjust the frequencies used for the square wave plot to create another plot of a sawtooth wave.)

   NOTE: A sawtooth wave looks something like this:

   ![Sawtooth Wave Example](image)

   (The more harmonics are added, the closer its shape comes to being a perfect sawtooth.)

As with the other plot submissions, just submit the chart plot. There is no need to submit the spreadsheet cells. An easy way to do this is to paste the chart into some other program and create the PDF from there.

This assignment uses the same techniques learned in earlier homework assignments. It should be done in Excel or an equivalent plotting program, using methodology shown in the textbook and in class. There should be at least 360 points plotted for each wave. **NOTE:** Extra credit is not meant to be a substitute for regular assignments. Extra credit will only be applied if credit has been received for all other assignments. It may be done at any time, and re-submitted if there are problems. No partial credit will be given for plots that are not accurate. No late submissions will be accepted after the final deadline shown on the Schedule.
Homework Packet 4 (5% of semester grade)

1. Compound Interest Problems worksheet. [Students who passed these problems on the optional pre-test do not need to submit this homework component.]
2. Logarithmic Fundamentals worksheet [Students who passed these problems on the optional pre-test do not need to submit this homework component.]
3. Logarithmic properties worksheet [Students who passed these problems on the optional pre-test do not need to submit this homework component.]
4. Write a paragraph that explains the distinction and relationship between air pressure levels and air particle velocity levels. Refer to the figure "Air Pressure Levels vs. Air Particle Velocity Levels" in the text.
5. Describe an example of sympathetic resonance that occurs in our environment.

Homework Packet 5 (3% of semester grade)

1. Intensity-Decibels Problems worksheet
2. Write a paragraph explaining why natural objects naturally vibrate in patterns that contain more than one frequency. For example, when a guitar string is plucked, what brings about simultaneous vibrations at different frequencies?
3. Describe the distinction between harmonics, partials, and overtones.

Homework Packet 6 (3% of semester grade)

Write at least three paragraphs describing the functions of the ear, including (but not limited to) the three parts of the ear, the functions of each, and the way the basilar membrane responds to frequency.

Homework Packet 7 (2% of semester grade)

Show how the ratios of a Ptolemaic just major scale (as shown in the textbook) occur naturally within the first six harmonics of the first, fourth, and fifth notes (1/1, 4/3, 3/2) of a scale. This may be handwritten. It should include a grid or table, as shown in the textbook chapter on tuning, which shows the fundamental, perfect fourth and perfect fifth all multiplied by the ratios of the first six harmonics. Indicate the ratios of the just major scale by circling or highlighting them. Disregard repeats; indicate only unique occurrences of each ratio. You should find that these 8 ratios consist of all of the ratios found in the just major scale.

Homework Packet 8 (3% of semester grade)

1. Frequencies of Strings and Transverse Bars problem sheet
2. Write a paragraph describing formants and why they are important to the timbre of instruments.
3. Write a paragraph (or a few paragraphs) comparing and contrasting brass and woodwind instruments. Topics should include, but are not limited to, different instruments in each family, excitation sources, differences in how pitches are played, special playing techniques for specific instruments, spectra of the instruments, directionality of their sound.

Homework Packet 9 (3% of semester grade)

Use an analysis program such as Sonic Visualiser (Mac OSX, Windows, Linux). (All of these are available in PSU computer labs as well as for free download).

Download samples from three different instrument families from the University of Iowa Electronic Music Studios Musical Instrument Samples page or the Philharmonia Samples page. Create a spectrogram for each file, save them as PDFs, and write at least a paragraph on each that describes its features.

On Macintosh, OPTION-click the links to the files to download them. (This may not work in all versions of Firefox. It does work in Safari.) On Windows, RIGHT-click to download.

NOTES ON OPENING FILES:
- In Sonic Visualizer, go to File -> Open to load a sound file, then go to Pane -> and choose one of the spectrogram options.

Different files will exhibit different characteristics. For each, consider at least the following:
- identifying the transient and steady state portions
- identifying the fundamental
- whether the file is harmonic or inharmonic
- does the file have much noise?
- what is its spectrum like -- few harmonics, all odd harmonics, all harmonics?
- a description of performance techniques demonstrated by performers who visited the class -- what do these techniques "look like"?

If these characteristics are not evident in a file, chances are you'll find something else worth discussing as you look for these features. Use the zoom function to adjust magnification levels.

BOTTOM LINE: Put the effort in and you'll discover something.
TO PRINT THE SPECTROGRAMS:
Not all of these programs allow spectrograms to be printed. You may need to take a screenshot of your spectrogram, which saves the screen as an image file, and save that image file as a PDF.
On Macintosh, type SHIFT+APPLE+3. The screen image will be saved as a TIFF file on the Desktop with a name like "Picture 1." This file will open in Preview by default if you double-click on it. Click here for more information on taking screenshots of an Apple computer screen.
On Windows, depress the Print Screen key on the computer keyboard to save the screen image to your clipboard, of ALT + Print Screen to copy just the screen of the software with your spectrogram. You can then paste it into some program (Paint, PhotoShop, MSWord, etc.) by pressing CTRL + v. Click here for more information on taking screenshots of a Windows computer screen.

CAUTIONARY NOTE:
Since this assignment has a number of new working methods, it would be wise to expect the unexpected. For a smooth process, it might be advisable to consider completing it over three work sessions:

1. Choose and download your audio files
2. Get to a computer running the software, and make sure you're comfortable with it
3. Do the analysis of the spectrograms

Homework Packet 10 (4% of semester grade)
Complete the sheet of room acoustics problems, which may be downloaded here.